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About This Guide

About This Guide

This guide describes how to install, configure, and use the webMethods SWIFTNet
Module, which supports synchronous communication of SWIFT messages and files
between client and server applications.

To use this guide effectively, you should:

B Have a basic knowledge of SWIFT and SWIFT terminology. For more information, go
to_http://www.swift.com.

B Have installed all necessary SWIFT software. You must work with SWIFT to
determine the appropriate software needs for your company.

B Have installed the webMethods Integration Server, the webMethods Trading
Networks (server side and console side) software, and the webMethods SWIFTNet
Module software. For more information about installing the non-SWIFT components,
see the webMethods Integration Platform Installation Guide.

B Be familiar with the webMethods Integration Server, the Server Administrator, and
webMethods Developer and understand the concepts and procedures described in
the webMethods Integration Server Administrator’s Guide and the webMethods Developer
User’s Guide.

B Be familiar with Trading Networks Console and understand the concepts and
procedures described in the various webMethods Trading Networks guides.

Document Conventions

Convention Description
Bold Identifies elements on a screen.
Italic Identifies variable information that you must supply or

change based on your specific situation or environment.
Identifies terms the first time they are defined in text. Also
identifies service input and output variables.

Narrow font Identifies storage locations for services on the webMethods

Integration Server using the convention folder.subfolder:service.
Typewriter Identifies characters and values that you must type exactly or
font messages that the system displays on the console.

UPPERCASE Identifies keyboard keys. Keys that you must press
simultaneously are joined with the “+” symbol.

webMethods SWIFTNet Module Installation and User’s Guide Version 6.0.1 5
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About This Guide

Convention Description

\ Directory paths use the “\” directory delimiter unless the
subject is UNIX-specific.

[1 Optional keywords or values are enclosed in [ ]. Do not type
the [ ] symbols in your own code.

Additional Information

The webMethods Advantage Web site at http://advantage.webmethods.com provides you
with important sources of information about your webMethods Integration Platform:

B Troubleshooting Information. The webMethods Knowledge Base provides
troubleshooting information for various webMethods components.

B Documentation Feedback. To provide documentation feedback to webMethods,
complete the Documentation Feedback Form on the webMethods Bookshelf.

B Additional Documentation. All of the webMethods documentation is available on the
webMethods Bookshelf.
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CHAPTER 1 Concepts

What Is SWIFTNet?

SWIFTNet is SWIFT's advanced IP-based messaging solution, which provides an alternate
method of transferring information to SWIFT. It consists of a portfolio of products and
services enabling the secure and reliable communication of financial information and
transactional data.

Messages and files exchanged between parties consist of SWIFTNetLink (SNL) primitives.
An SNL primitive is a pair of XML documents that is passed between an application
program and the SNL software on your SWIFTAlliance Gateway (SAG) server. Each
primitive document pair represents the invocation of a SWIFTNet processing function
and includes an ‘in” document and a corresponding ‘out’ document. These documents are
either 1) the input for a function call to SWIFTNet, or 2) the SWIFTNet output of a
function call.

SWIFTNet includes three messaging services:

B SWIFTNet InterAct. Allows the interactive (real-time) and store-and-forward exchange
of messages between parties. It provides secure communication facilities for
transferring messages up to 100KB. As the foundational messaging service of
SWIFTNet, the InterAct Services include not only the InterAct Request/Response
primitives, but also all of the supporting SWIFTNet infrastructure.

B SWIFTNet FileAct. Allows the exchange of files in an automated way, supporting both
interactive (real-time) and store-and-forward modes. It provides secure
communication facilities for transferring files. FileAct is oriented toward transferring
data larger than the InterAct payload can accommodate.

B SWIFTNet Browse. Enables secure browser-based access to service providers’ web
servers. This service provides direct access to the secure messaging features of
SWIFTNet InterAct and SWIFTNet FileAct. (This set of services is not currently
supported by the webMethods SWIFTNet Module.)

For more information about SWIFT and SWIFTNet, see the documentation provided by
SWIFT or go to http://www.swift.com.
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What Is the webMethods SWIFTNet Module?

What Is the webMethods SWIFTNet Module?

The webMethods SWIFTNet Module supports synchronous communication of SWIFT
messages and files between client and server applications. A client application is one that
sends a request and receives a response. A server application is one that receives a request
and sends a response.

@ Important! Because client and server applications cannot co-exist in the same process, if you
want to use both the client and server application services, you must install the
webMethods SWIFTNet Module on two different Integration Servers. You must use only
the WmSWIFTNetClient packages on one Integration Server and only the
WmSWIFTNetServer packages on the other Integration Server.

The SWIFTNet Module provides client-side and server-side support for the following
messaging services and capabilities:

B InterAct Services

B FileAct Services

@ Important! This release of the webMethods SWIFTNet Module does not support Store-and-
Forward capabilities. Without Store-and-Forward, this module requires that both parties
be online for any transfer of information. Store-and-Forward will be supported in a future
release.

As mentioned earlier, InterAct and FileAct are implemented as a set of SNL primitives
that are exchanged between the client or server application program and the SNL
software on your SAG server. Along with its packages, the SWIFTNet Module provides
two DLLs, WrSW FTNet O i ent . dI | and WrSW FTNet Ser ver . dl | , that invoke the
functionality of the SNL libraries to transfer the SNL primitives between the client and
server applications.

For more information about the packages in this module, see “webMethods SWIFTNet
Module Packages” on page 13 in this chapter.

Client Application Functionality

The WisW FTNet Ol i ent . dI | invokes functionality for a client application, which sends a
request to and receives a response from a server application. When using the module with
a client application, you can do the following:

B Send an InterAct request message and receive a response
B Putafile

B Getafile

webMethods SWIFTNet Module Installation and User’s Guide Version 6.0.1 9
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Server Application Functionality

The WiSW FTNet Ser ver . dI | invokes functionality for a server application, which
receives a request from and sends a response to a client application. When using the
module with a server application, you can do the following:

B Receive an InterAct request message and send a response
B Accept a put file request from the client application
B Accept a get file request from the client application

For more information about the architecture of the module, see “webMethods SWIFTNet
Module Architecture” on page 11 in this chapter.

SNL Request and Response Primitives Support

The webMethods SWIFTNet Module supports all of the SNL request and response
primitives involved in synchronous communication between client and server
applications:

B Sw:HandlelnitRequest
Sw:HandlelnitResponse
SwSec:CreateContextRequest
SwSec:CreateContextResponse

Sw:SubscribeFileEventRequest

Sw:SubscribeFileEventResponse

Processing of SNL Primitives

When the SAG server receives a request from a client application, the
wm.swiftnet.server.services:handleRequest service is invoked in the Integration Server on which
the server application is installed. The handleRequest service then invokes the wm.tn:receive
service.

Trading Networks uses the TN document types that you create to recognize the incoming
request, saves the request to the Trading Networks database, and invokes one of the
processing rules you created and associated with the request’s TN document type. The
processing rule processes the document as necessary and generates output containing the
string xmIResponse, which is the response to be sent back to the client application. The
following diagram illustrates the process.

10
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webMethods SWIFTNet Module Processing

SNL
Primitive
Request

(WmSWIFTNetClient.dll)

SNL
Primitive
Respons

WIFTNetServer.dll)

webMethods SWIFTNet Module Architecture

The following diagram illustrates the components involved in transferring messages and
files using the webMethods SWIFTNet Module.

SWIFTNet Module Architecture

Server SAG Server

As indicated in the diagram, the components listed in the following table comprise and
support the SWIFTNet Module.

Component Description

Integration Server webMethods Integration Server is the underlying server of the
webMethods Integration Platform. You use the web-based user
interface, Server Administrator, to manage, configure, and
administer all aspects of the Integration Server, such as users,
security, packages, and services.

For more information, see the webMethods Integration Server
Administrator’s Guide.

webMethods SWIFTNet Module Installation and User’s Guide Version 6.0.1 11
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Component

Description

Trading Networks

webMethods Trading Networks enables your enterprise to link
with other financial institutions and marketplaces to form a
business-to-business trading network. In this instance, Trading
Networks enables the webMethods SWIFTNet Module to
exchange messages and files with your SWIFTAlliance Gateway
(SAG) server.

For more information about Trading Networks, see the
webMethods Trading Networks—Getting Started with Trading
Networks and the webMethods Trading Networks—Building Your
Trading Network guides.

RA

The Remote Access (RA) client enables the SWIFTNet Module to
communicate with your SAG server and SNL through your
Remote Access Host Adapter (RAHA). You must install an RA
client on the same machine as the Integration Server.

To obtain an RA client, contact SWIFT.

RAHA

Your RAHA enables your SAG server to exchange messages
and files with the Remote Access (RA) client on your Integration
Server. You must install an Remote Access Host Adapter
(RAHA) on the same machine as the SAG server.

To obtain an RAHA, contact SWIFT.

SAG Server/SNL

Your SWIFTAIlliance Gateway (SAG) server, on which you
install your SWIFTNetLink (SNL) software, must be configured
to exchange messages and files with SWIFTNet. You also will
use this configuration information to configure the SWIFTNet
Module and your RA client.

Important! In addition to using RAHA, you can communicate with your SAG server and
SNL using MQSeries Adapter or File Transfer Agent. For more information, see
Appendix A, “Configuring Transport Protocols” in this guide.

12
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webMethods SWIFTNet Module Packages

The webMethods SWIFTNet Module contains two sets of packages, which contain
webMethods services and related files, that you install on the webMethods Integration
Server. The following table describes the contents of each package.

Important! Because client and server applications cannot co-exist in the same process, if you
want to use both the client and server application services, you must install the
webMethods SWIFTNet Module on two different Integration Servers. You must use only
the WmSWIFTNetClient packages on one Integration Server and only the
WmSWIFTNetServer packages on the other Integration Server.

Package Description

WmSWIFTNetClient Contains the FileAct and InterAct services that support
SWIFTNet Module client-side functionality.

WmSWIFTNetClientSample  Contains a sample implementation of the SWIFTNet
Module client-side functionality.

WmSWIFTNetServer Contains the FileAct and InterAct services that support
SWIFTNet Module server-side functionality.

WmSWIFTNetServerSample  Contains a sample implementation of the SWIFTNet
Module server-side functionality.

For detailed information about the contents of the these packages, see Appendix 5,
“webMethods SWIFTNet Module Services” in this guide.

webMethods SWIFTNet Module Installation and User’s Guide Version 6.0.1 13
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CHAPTER 2 Installing the webMethods SWIFTNet Module

Overview

Important! The information in this chapter might have been updated since the guide was
published. Go to the webMethods Advantage Web site at
http://advantage.webmethods.com for the latest version of the guide.

System Requirements

This section describes the system requirements that must be met before you can install the
webMethods SWIFTNet Module.
Platform and Operating System Requirements

The following table lists the supported platforms for the SWIFTNet Module and the Java
virtual machine (JVM) to use for each platform.

Platform and Operating System Supported JVMs
Microsoft Windows NT 4.0 SP4 JRE 1.3
Microsoft Windows 2000 and XP Professional JRE 1.3

webMethods Software Requirements

The following table lists the webMethods components you must install before you can
install the SWIFTNet Module:

Component

webMethods Integration Server 6.0.1

webMethods Developer 6.0.1
webMethods Trading Networks 6.0.1

Third-Party Software Requirements

Regardless of whether you are using the SWIFTNet Module for a client or server
application, you must install a Remote Access (RA) client on your Integration Server. If
you are using the SWIFTNet Module for a server application, you must install a Remote
Access Host Adapter (RAHA) on the same machine as the SAG server. Both the RA client
and the RAHA are provided by SWIFT. For more information, see your SWIFT
documentation or go to http://www.swift.com.

16 webMethods SWIFTNet Module Installation and User’s Guide Version 6.0.1
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Installing webMethods SWIFTNet Module

Hardware Requirements

The SWIFTNet Module does not have any requirements in excess of those for
webMethods Integration Server.

Installing webMethods SWIFTNet Module

Important! This section provides only instructions that are specific to installing the
webMethods SWIFTNet Module. For complete instructions on using the webMethods
Installer, see the webMethods Integration Platform Installation Guide.

Important! You must have administrator privileges on the webMethods Integration Server
to execute these procedures. If you do not have administrator privileges, have your
webMethods Integration Server administrator perform these procedures.

P install the SWIFTNet Module

1

4

Download webMethods Installer 6.0.1 from the webMethods Advantage Web site at
http://advantage.webmethods.com and start the installer.

Run the installer using the username and password you received from webMethods.
Specify the installation directory as the webMethods 6.0.1 installation directory (by
default, webMethods6).

In the component selection list, navigate to webMethods Platform » eStandards »
webMethods SWIFTNet Module and select one of the following components to install:

a  SWIFTNet Module Client to install the client component.

b SWIFTNet Module Server to install the server component.

Each component includes the following selections:
®  Documentation 6.0.1 (Optional). Contains the documentation for this package.
®  Program Files 6.0.1(Required). Contains the program files for this package.

m  Samples 6.0.1 (Optional, but recommended). Contains the services that
demonstrate how to use the SWIFTNet Module services.

® In addition, select any required webMethods components you have not installed.

Click Next until the installer displays the Installation Complete panel.

webMethods SWIFTNet Module Installation and User’s Guide Version 6.0.1 17
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5 Click Close.

Important! You must configure your SWIFTNet Module and configure and start your
SWIFTAlliance Gateway (SAG) server before starting the Integration Server on which you
have installed the SWIFTNet Module. If at any time the SAG server goes down, you must
restart the Integration Server on which you have installed the SWIFTNet Module.

The webMethods SWIFTNet Module starts automatically when you start the webMethods
Integration Server.

Uninstalling webMethods SWIFTNet Module

Important! This section provides only instructions that are specific to uninstalling the
webMethods SWIFTNet Module. For complete instructions on using the webMethods
Installer, see the webMethods Integration Platform Installation Guide.

Important! If you want to keep certain records or services that you use with the existing
webMethods SWIFTNet Module packages on your webMethods Integration Server, make
sure that you export them to a new package (from webMethods Developer, select the
package to export, and select File » Export) before performing the following procedure,
which will remove all components in the packages.

You perform the following procedure when you want to completely uninstall the
webMethods SWIFTNet Module.

P 7o uninstall the SWIFTNet Module from webMethods Integration Server

1 The instructions in the webMethods Integration Platform Installation Guide say to shut
down all webMethods components and applications that are running on your
machine. For SWIFTNet Module, you need to shut down only the Integration Server.

2 Select webMethods SWIFTNet Module as the program to uninstall.

3 The uninstaller removes all SWIFTNet Module-related files that were installed into
the Integration Server_directory\packages directory. The uninstaller does not delete
files created after you installed the SWIFTNet Module (for example, user-created or
configuration files), nor does it delete the directory structure that contains the files.

4 If you want to delete the files that the uninstaller did not delete, navigate to the
Integration Server_directory\packages directory and delete the related folders.

You perform the following procedure when you want to uninstall portions of the
SWIFTNet Module.

I 1o uninstall portions of the SWIFTNet Module from webMethods Integration Server

18 webMethods SWIFTNet Module Installation and User’s Guide Version 6.0.1
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1  Start the webMethods Integration Server and the Server Administrator.

2 Under the Package menu in the Server Administrator navigation area, click
Management.

3 From the Package list, locate the following packages:
B WmSWIFTNetClient
B WmSWIFTNetClientSample
B WmSWIFTNetServer
B WmSWIFTNetServerSample
4 Select one of the following options for each of the desired packages:
m  Select Delete to delete the package without keeping a backup copy.

m  Select Safe Delete to remove the package and keep a backup copy. (Backup copies
are stored in the ServerDirectory\replicate\salvage directory on the server.)

5 Refresh your Web browser. The selected packages are removed.

webMethods SWIFTNet Module Installation and User’s Guide Version 6.0.1 19
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CHAPTER 3 Configuring the webMethods SWIFTNet Module

Overview

AN

This chapter describes how to prepare your server application or your client application
to exchange messages and files over SWIFTNet using the SWIFTNet Module.

Important! The following steps assume that you already have installed the webMethods
Integration Server, webMethods Trading Networks, and the webMethods SWIFTNet
Module, and have imported a BIC or BIC+ list. For steps to install the webMethods
SWIFTNet Module, see Chapter 2, “Installing the webMethods SWIFTNet Module” in this
guide. For more information about BICs, see the webMethods SWIFT FIN Module
Installation and User’s Guide. For more information about what SWIFT software you need,
work with SWIFT to determine your software needs.

Preparing the Server Side to Receive and Respond to Requests

To prepare your server application to receive and respond to requests using the
SWIFTNet Module, you must complete three stages of configuration;

B Stage 1: Configure the SWIFTAlliance Gateway Server
B Stage 2: Configure the SWIFTNet Module

B Stage 3: Configure Your Integration Server

Stage 1: Configure the SWIFTAIlliance Gateway Server

To configure your SAG server to communicate with your RA client, SWIFTNet Module,
and Integration Server, complete the following steps:

B nstall a Remote Access Host Adapter (RAHA). Install an RAHA on the same machine as the
SAG server. Your RAHA enables your SAG server to exchange messages and files
with the RA client on your Integration Server. To obtain an appropriate RAHA,
contact SWIFT.

B Configure your message partners

For more information about completing these steps, see the SWIFTAIlliance Gateway File
Transfer Interface Guide, the SWIFTAlliance Gateway Operations Guide, and the
SWIFTAIlliance Gateway Remote API Operations Guide.

Important! If at any time the SAG server goes down, you must restart the Integration Server
on which you have installed the SWIFTNet Module.

22
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Stage 2: Configure the SWIFTNet Module

To configure your SWIFTNet Module, complete the following steps:
B Step 1: Install a Remote Access Client

B Step 2: Add DLLs to the Integration Server CLASSPATH

B Step 3: Set the Integration Server Environment Variables
|

Step 4: Edit the webMethods SNL Configuration File

Step 1: Install a Remote Access Client

Install a Remote Access (RA) client on the same machine as the Integration Server. The RA
client enables the SWIFTNet Module to communicate with your SAG server and SNL
through your Remote Access Host Adapter (RAHA). To obtain an RA client, contact
SWIFT.

Step 2: Add DLLs to the Integration Server CLASSPATH

Copy the WiSW FTNet Ser ver . dI | from the webMet hods6\ | nt egr at i onServer \
packages\ WiSW FTNet Ser ver directory, and then paste the DLL into one of the
directories contained in the PATH environment variable available to the Integration
Server (preferably into the webMet hods6\ | nt egr ati onServer\ i b directory).

For the WrSW FTNet Ser ver . dl | files to function properly, the DLLs listed in the following
table must be copied from your SAG server and pasted into one of the folders contained in
the PATH environment variable available to the Integration Server (preferably into the
webMet hods6\ | nt egr ati onServer\|ib directory):

B |ibftla_handler.dll B |ibsagapli_20.dlI
B |ibsagapp_20.dlI B |ibsagcm 20.dl1I

B |ibsagcmutil.dll B |ibsagcontrol _20.dlI
B |ibsagcontrol _util_20.dlI B |ibsagdb.dll

B |ibsagextractor.dll B |ibsagoh_20.dlI

B |ibsagpl ugin_20.dlI B |ibsagprinmtive.dll
B |ibsagra_20.dlI B |ibsagtypes_20.dlI
B |ibswonmmdll B |ibswexception.dll
B |ibswnk.dllI B |ibswosl.dll

B |ibsweportevt.dll B |ibswsec.dll

B |ibswstring_20.dlI B |ibswrace.dl|l

webMethods SWIFTNet Module Installation and User’s Guide Version 6.0.1 23



CHAPTER 3 Configuring the webMethods SWIFTNet Module

B |ibswtransport.dll B libswutil_xm.dll

B xerces-c_1_7_0.dlI

Step 3: Set the Integration Server Environment Variables

For the WiSW FTNet Ser ver . dl | file to communicate with your RA client, you must set the

your system environment variables as follows:

ARCH=wW n32

GENLOG DI R=C: \ SW FTAl | i ance\ RA\ Ral\ | og
GENUTI L_DI R=C: \ SW FTAI | i ance\ RA\ bi n
OSA DI R=C:\ SW FTAI | i ance\ RA\ Ral\ | og
OSA_| NSTANCE=Ral

Pat h=C:\ SW FTAI | i ance\ RA\ bi n; C.\SWFTAl | i ance\ RA\ |l i b;

PKI EXECDI R=C: \ SW FTAI | i ance\ RA
SLP_ENV=DEFAULT

SLP_FI LE=server.slp

SNL_DOVAI N_NAME=Ral

SPK_DATA DI R=C. \ SW FTAI | i ance\ RA\ dat a\ pki
SWNET_BI N_PATH=C: \ SW FTAI | i ance\ RA\ Ral\ bi n
SWNET_CFG_PATH=C:. \ SW FTAl | i ance\ RA\ Ral\ cfg
SVWNET_HOST=HOSTNAME

SWNET_HOME=C: \ SW FTAl | i ance\ RA

SWNET_| NST=Ral

SWNET_LOG _PATH=C: \ SW FTAI | i ance\ RA\ Ral\l og
SWNET_SLP_PATH=C:. \ SW FTAI | i ance\ RA\ dat a\
SWIRACE=C: \ SW FTAI | i ance\ RA\ Ral\ | og

Step 4: Edit the webMethods SNL Configuration File

At startup, the WmSWIFT NetServer package automatically registers itself as the server
application with the SNL libraries on your SAG server and exchanges a series of pre-
defined SNL primitives in sequence with your SNL libraries using your RA client. The
information required to populate these primitives is retrieved from the

webMet hods6\ | nt egr at i onSer ver \packages\ WiSW FTNet Ser ver\ confi g\ snl . cnf

file. Following is an example of the contents of the file snl . cnf file;

# Properties for FileAct/InterAct Server
SAGVessagePar t ner =ser ver

server _pki _profil e=user

server _pki _passwor d=password

Si gn=FALSE

Decr ypt =FALSE

Aut hori sati on=TRUE

encrypt DN=cn=Di st i ngui shedNane, o=ptsausaa, o=swi ft
Al'l Fi |l eEvent s=TRUE

Ful | Fi |l eSt at us=TRUE

SwEvent EP=Fi | e_St at us_Event _EP

crypt oMbde=Aut ormat i ¢
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For the SWIFTNet Module to exchange information with your SAG server, you must set
the parameters in this file using the information you used to configure your SAG server in
“Stage 1: Configure the SWIFTAIlliance Gateway Server” on page 22 in this chapter and as
indicated in the following table.

Set this parameter...

To...

SAGMessagePartner

The “Server” message partner defined in your SAG server.

server_pki_profile

The user name of the “Server” profile defined in your SAG
server.

server_pki_password

The password associated with the user name of the “Server”
profile defined in your SAG server. This is used to unlock the
security information in your SAG server.

Sign, Decrypt, and
Authorisation

The value is used to populate the SwSec:CreateContextRequest
primitive exchanged during server initialization. Valid values:
True and Fal se.

encryptDN

The Distinguished Name to be used for encryption operations.

AllFileEvents and
FullFileEvents

The value is used to populate the Sw:SubscribeFileEventRequest
primitive exchanged during server initialization. Valid values:
True and Fal se.

SwEventEP The end point defined in your SAG server to handle FileAct
operations. This value is used to populate the
Sw:SubscribeFileEventRequest primitive exchanged during
server initialization.

cryptoMode The value specifies whether your SAG server automatically

performs crypto operations. Valid values: Aut omat i ¢ and
Manual

Stage 3: Configure Your Integration Server

To configure your Integration Server, start the Integration Server on which you have
installed the SWIFTNet Module and complete the following steps:

B Step 1: Define Trading Partner Profiles

Step 2: Define TN Document Types

|
B Step 3: Create Mapping Services
|

Step 4: Define Processing Rules
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Step 1: Define Trading Partner Profiles

In the webMethods Trading Networks Console, you define the trading partner profiles for
yourself and all financial institutions with whom you want to exchange messages and
files.

For more information about defining trading partner profiles for use with the SWIFTNet
Module, see Chapter 4, “Defining Trading Networks Information” in this guide.

Step 2: Define TN Document Types

TN document types are definitions that tell webMethods Trading Networks how to
identify the incoming SNL request primitives and specify the processing rule you want to
use to process the document. You must create a TN document type for each type of
request you will be handling.

The SWIFTNet Module provides sample TN document types in the

webMet hods6\ | nt egr at i onSer ver \packages\ WiSW FTNet Ser ver Sanpl e\ confi g\
Server DocTypes. xmi file. You can import these TN document types into Trading
Networks and then modify them or use them to create new TN document types.

For information about importing and creating TN document types, see Chapter 4,
“Defining Trading Networks Information” in this guide. For general information about
using TN document types, see the webMethods Trading Networks--Building Your Trading
Network guide.

Step 3: Create Mapping Services

To perform InterAct and FileAct operations, SNL primitives must be invoked in particular
sequences. A mapping service defines in what order to invoke the SNL primitives, how to
process the request, and what response to send back to the client application. You must
create a mapping service for each type of request you will be handling.

The webMethods SWIFTNet Module provides sample services in the
webMet hods6\ | nt egr at i onSer ver \packages\ WrSW FTNet Ser ver Sanpl e directory that
you can use or on which you can base new services.

To function properly, all of the mapping services you create must meet the following
requirements:

B The input/output signature must conform to the specification
wm.swiftnet.server.doc: SWIFTNetServerSideProcessingRule in the WmSWIFTNetServer
package. To do so, in Developer specify the SWIFTNetServerSideProcessingRule service in
the Specification Reference field on the Input/Output tab of the mapping service as
illustrated in the following figure.

R GLLIEEE L sl

Tigw TECPAREN | Cpiwgs | dxd | Petrmaom| Arednm

L n ] T TORT B — ol TP e B e B 5 L= 2 L |

26 webMethods SWIFTNet Module Installation and User’s Guide Version 6.0.1



Preparing the Client Side to Send Requests and Receive Responses

B The output must contain a string xmlIResponse. This is the response to the incoming
request that the server application sends back to the client application.

For more information about this service, see Appendix 5, “webMethods SWIFTNet
Module Services” in this guide.

Step 4: Define Processing Rules

Processing rules enable you to process incoming requests. You assign a processing rule to
a particular TN document type so that when Trading Networks identifies a request, it
processes that request according to the settings in the processing rule, including which
mapping service should be invoked. You must create a processing rule for each type of
request you will be handling.

The SWIFTNet Module provides sample processing rules in the

webMet hods6\ | nt egr at i onSer ver \packages\ WrSW FTNet Ser ver Sanpl e\ confi g\
Ser ver Processi ngRul es. xnl file. You can import these processing rules into Trading
Networks and then modify them or use them to create new processing rules.

For information about importing and creating processing rules, see Chapter 4, “Defining
Trading Networks Information” in this guide. For general information about using
processing rules, see the webMethods Trading Networks--Building Your Trading Network
guide.

You now are ready to receive requests and send responses.

Preparing the Client Side to Send Requests and Receive
Responses

To prepare your client application to exchange messages and files over SWIFTNet using
the webMethods SWIFTNet Module, you must complete the following steps:

B Step 1: Install a Remote Access Client
Step 2: Add DLLs to the Integration Server CLASSPATH
Step 3: Set the Integration Server Environment Variables

Step 4: Edit the webMethods SNL Configuration File

Step 5: Invoke wm.swiftnet.client.services:swArguments

Step 1: Install a Remote Access Client

Install a Remote Access (RA) client on the same machine as the Integration Server. The RA
client enables the SWIFTNet Module to communicate with the SAG server and SNL
through the Remote Access Host Adapter (RAHA). To obtain an RA client, contact
SWIFT.
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Step 2: Add DLLs to the Integration Server CLASSPATH

Copy the WisW FTNet Cl i ent . dI | from the webMet hods6\ | nt egr at i onSer ver \
packages\ WiSW FTNet Ser ver directory, and then paste the DLL into one of the
directories contained in the PATH environment variable available to the Integration
Server (preferably into the webMet hods6\ | nt egr ati onServer\ i b directory).

For the wisW FTNet Cl i ent . dI | files to function properly, the DLLs listed in the
following table must be copied from your SAG server and pasted into one of the folders
contained in the PATH environment variable available to the Integration Server
(preferably into the webMet hods6\ | nt egr ati onServer\ | i b directory):

libftla_handler.dll

i bsagapp_20. dl |

I'i bsweportevt.dll
l'i bswstring_20.dlI

I'i bswtransport.dll

B |ibsagcmutil.dll
B |ibsagcontrol _util_20.dlI
B |ibsagextractor.dll
B |ibsagpl ugin_20.dlI
M |ibsagra_20.dlI

B |ibswommdll

B |ibsw nk.dll

|

|

|

|

xerces-c_1 7_0.dll

i bsagapli _20.dlI
I'i bsagcm 20. dl |

i bsagcontrol _20.dl |
l'i bsagdb. dl |

I'i bsagoh_20. dl |
libsagprimtive.dll
i bsagtypes_20.dl |
i bswexception. dl |
I'i bswposl . dl |

i bswsec. dl |

l'i bswtrace. dl |

libsw util _xm.dll

28
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Step 3: Set the Integration Server Environment Variables

For the WiSW FTNet Ol i ent . dI | file to communicate with your RA client, you must set the
your system environment variables as follows:

ARCH=wi n32

GENLOG DI R=C: \ SW FTAl | i ance\ RA\ Ral\ | og
GENUTI L_DI R=C: \ SW FTAI | i ance\ RA\ bi n

OSA DI R=C:\ SW FTAI | i ance\ RA\ Ral\ | og

OSA_| NSTANCE=Ral

Pat h=C: \ SW FTAl | i ance\ RA\ bi n; C:\ SWFTAl | i ance\ RA\ | i b;
PKI EXECDI R=C: \ SW FTAI | i ance\ RA
SLP_ENV=DEFAULT

SLP_FI LE=server.slp

SNL_DOVAI N_NAME=Ral

SPK_DATA DI R=C: \ SW FTAI | i ance\ RA\ dat a\ pki
SWNET_BI N_PATH=C: \ SW FTAI | i ance\ RA\ Ral\ bi n
SWNET_CFG_PATH=C:. \ SW FTAI | i ance\ RA\ Ral\ cfg
SWNET_HOST=HOSTNAME

SWNET_HOME=C: \ SW FTAl | i ance\ RA

SWNET_| NST=Ral

SWNET_LOG _PATH=C:. \ SW FTAI | i ance\ RA\ Ral\l og
SWNET_SLP_PATH=C: \ SW FTAI | i ance\ RA\ dat a\
SWIRACE=C: \ SW FTAI | i ance\ RA\ Ral\ | og

Step 4: Edit the webMethods SNL Configuration File

The information required to send SNL primitives to the server application is retrieved
from the configuration webMet hods6\ | nt egr at i onSer ver \packages\

WSW FTNet d i ent\ confi g\ snl . cnf file. Following is an example of the contents of the
file snl . cnf file:

# Properties for FileAct/InterAct Server
SAG\VessagePar t ner =cl i ent

server _pki _profil e=user

server _pki _passwor d=password

encrypt DN=cn=Di st i ngui shedNane, o=ptsausaa, o=swi ft
crypt oMbde=Aut ormat i ¢

For the SWIFTNet Module to exchange information with the SAG server, you must set the
parameters in this file as indicated in the following table.

Set this parameter... To...

SAGMessagePartner A “Client” message partner defined in the SAG server.

server_pki_profile The user name of a “Client” profile defined in the SAG server.

server_pki_password  The password associated with the user name of a “Client” profile
defined in the SAG server. This is used to unlock the security
information in the SAG server.
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Set this parameter... To...

encryptDN The Distinguished Name to be used for encryption operations.

cryptoMode The value specifies whether the SAG server automatically
performs crypto operations. Valid values: Aut omat i ¢ and
Manual .

Step 5: Invoke wm.swiftnet.client.services:swArguments

Before exchanging any primitives with the SAG server using the SWIFTNet Module, the
client application must invoke the wm.swiftnet.client.services:swArguments service in the
WmSWIFTNetClient package at least once. The only parameter required to be passed to
this service is SAGMessagePartner, which is the message partner defined as the “Client” in
your SAG server during configuration. The format in which this argument has to be
passed is illustrated in the wm.swiftnet.client.sample.fileAct:swExchangeFile service in the
WmSWIFTNetClientSample package.

For more information about these services, see Appendix 5, “webMethods SWIFTNet
Module Services” in this guide.
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Overview

Trading partner profiles help define how you and your trading partners exchange SWIFT
messages and files. TN document types enable webMethods Trading Networks to identify
a type of business document and specify what to extract from the business document.
Processing rules tell Integration Server how to process the incoming requests for server
applications.

This chapter provides you with information about defining trading partner profiles, TN
document types, and processing rules in webMethods Trading Networks.

Defining Trading Partner Profiles

A trading partner is any person or organization with whom you want to conduct business
electronically. In the webMethods SWIFTNet Module, a trading partner is defined by
several criteria that you specify in a trading partner profile, including company name and
identifying information, contact information, and preferred delivery methods.

In addition to specifying trading partner profiles for all of your trading partners, you
must specify a profile for your own organization.

Why Are Trading Partner Profiles Important?

Your trading partner profiles define how you exchange messages and files with your
partners. In fact, the concise definition of profiles and the configuration of processing
rules are what enable you to interact successfully with your trading partners.

For the SWIFTNet Module, you define a single trading partner profile for yourself (My
Enterprise). You also must define a trading partner profile for each trading partner with
whom you will be exchanging messages and files.

Defining Your Enterprise Profile

Before defining your trading partner profiles in Trading Networks and exchanging
messages and files, you first must define your enterprise (My Enterprise) profile by
completing the fields in the Profile Assistant in the Trading Networks Console.

For procedural information about defining your enterprise profile as well as descriptions
of all the fields you must complete when defining your enterprise profile, see the
webMethods Trading Networks--Building Your Trading Network guide. The following section
provides you with the fields that you are required to complete when defining your
enterprise profile for use with the SWIFTNet Module.
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Required Profile Fields

Profile information is displayed on the Trading Networks Console Profile Assistant
Corporate tab. The following table lists and describes the required fields you must
complete when defining your enterprise profile for use with the SWIFTNet Module.

Required Profile Field for My Enterprise Description

Corporation Name The name of your enterprise.
External ID Type BIC
External ID Type Value Your enterprise’s BIC.

For descriptions of other fields you must complete when you defining your enterprise
profile, see the webMethods Trading Networks--Building Your Trading Network guide.

Defining Trading Partner Profiles

Each trading partner with whom you want to exchange messages and files must have a
trading partner profile in Trading Networks. After you have defined your enterprise
profile, you are ready to define your trading partners’ profiles.

You define a trading partner profile by completing the fields in the Profile Assistant in the
Trading Networks Console.

For procedural information about defining a trading partner profile as well as
descriptions of the fields you must complete when defining a trading partner profile, see
the webMethods Trading Networks--Building Your Trading Network guide. The following
section provides you with the fields that you are required to complete when defining your
trading partner profiles for use with the SWIFTNet Module.

Required Profile Fields

Profile information displays on the Trading Networks Console Profile Assistant Corporate
tab. The following table lists and describes the required fields you must complete when
defining a trading partner profile.

Required Profile Field for Trading Partner  Description

Corporation Name The name of the trading partner.
External ID Type BIC
External ID Type Value Your trading partner’s BIC.

For descriptions of other fields you must complete when you define a trading partner
profile, see the webMethods Trading Networks--Building Your Trading Network guide.
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Defining TN Document Types

TN document types are definitions that tell webMethods Trading Networks how to
identify the incoming SNL request primitives and specify the processing rule you want to
use to process the document. You must create a TN document type for each type of
request you need to handle.

When the webMethods SWIFTNet Module receives a request, it invokes a Trading
Networks service to recognize the incoming requests (SWIFTNet primitives) for server
applications using the TN document types that you created. When Trading Networks
recognizes the TN document type of the incoming request, Trading Networks extracts
specific pieces of information from the business document based on the attributes
specified in the TN document type.

The SWIFTNet Module provides sample TN document types in the

webMet hods6\ | nt egr at i onSer ver \packages\ WiSW FTNet Ser ver Sanpl e\ confi g\
Server DocTypes. xmi file. You can import these TN document types into Trading
Networks and then modify them or create new TN document types. For more information
about TN document types, see the webMethods Trading Networks--Building Your Trading
Network guide.

Importing the Sample TN Document Types

I Toimport the sample TN document types

1  Start the Integration Server, Server Administrator, and Trading Networks Console, if
they are not already running.

2 Inthe Trading Networks Console, click File » Import.

3 To select the TN document type file, click 3.

4 Navigate to webMet hods6\ | nt egr at i onSer ver\ packages\
WSW FTNet Ser ver Sanpl e\ conf i g\ Ser ver DocTypes. xn , and click Open. The TN
document types are listed on the Import Data screen.

5 Click E'E'}| to select all of the TN document types and then click OK. The TN document
types are imported.
6 Now you can copy and modify these TN document types as necessary.

For more information about TN document types, see the webMethods Trading Networks--
Building Your Trading Network guide.
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Creating TN Document Types

When you define an internal TN document type, you specify the root tag from within the
SNL primitive that the TN document type is to match and define the four prefixes that the
TN document type should recognize.

B 1o create an internal TN document type

1  Start the Integration Server, Server Administrator, and Trading Networks Console, if
they are not already running.

In the Selector Panel, click My Enterprise.
Select View » Document Types.

Select Types » New.

o B~ W N

In the Create New DocType dialog box, select the XML document type category from the
list, and click OK.

6 Inthe Document Type Details screen, in the Name field, type the name you want to give to
the internal TN document type.

7 In the Description field, type a description for the internal TN document type.

8 On the Identify tab, in the Root Tag field, type the value of the root tag of your internal
document. For example, SW nt : Handl eRequest .
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The following figure illustrates the Identify tab of the Document Type Details screen with
the necessary fields completed.
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Note: You can tell whether a TN document type is internal or external because an
external TN document type always has a pipeline matching variable of processVersion.
The TN document type in the preceding figure has no pipeline matching variable, so it
is an internal TN document type.

9 On the Namespaces tab, click IE to define each of the following prefixes:

= Sw

m  SwSec
m  Swint

m SwGbl

Note: You can enter anything in the URL field, but the prefixes must be entered exactly
as listed in step 9.
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The following figure illustrates the Namespaces tab of the Processing Rule Details screen
with the necessary fields completed.
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10 Click OK.

For more information about TN document types, see the webMethods Trading Networks--
Building Your Trading Network guide.

Defining Processing Rules

Processing rules process the incoming requests (SNL primitives) for server applications
by invoking mapping services that you create. The webMethods SWIFTNet Module
provides sample processing rules in the webMet hods6\ I nt egr ati onSer ver \

packages\ WiSW FTNet Ser ver Sanpl e\ confi g\ Ser ver Processi ngRul es. xnmi file. You
can import the processing rules in this file using the Trading Networks Console and then
modify them or create new processing rules.

Importing the Sample Processing Rules

I o import the processing rules

1

Start the Integration Server, Server Administrator, and Trading Networks Console, if
they are not already running.

In Trading Networks, select File » Import.

In the Import dialog box, click (3 to select the processing rule file.

Navigate to webMet hods6\ | nt egr at i onSer ver\ packages\
WYBW FTNet Ser ver Sanpl e\ conf i g\ Ser ver Processi ngRul es. xmi , and click Open.
The processing rules are listed on the Import Data screen.

Click W| to select all of the processing rules and then click OK. The processing rules
are imported.
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Creating Processing Rules

When you define a processing rule, you specify the mapping service to invoke to send the
appropriate response back to the client application.

- To create a processing rule

1  Start the Integration Server, Server Administrator, and Trading Networks Console, if
they are not already running.

In the Selector Panel, click My Enterprise.
Select View » Processing Rules.

Select Types » New.

g AW N

In the Processing Rule Details screen, in the Name field, type the name you want to give
to the processing rule.

6 Inthe Description field, type a description for the processing rule.
7 On the Criteria tab, select the TN document type associated with the processing rule.

The following figure illustrates the main screen and the Criteria tab of the Processing
Rule Details screen with the necessary fields completed.
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8 On the Action tab, click the Perform the following actions radio button.

9 Select the Execute a service check box and specify the mapping service that you want
this processing rule to execute.

To function properly, the mapping service you specify must meet the following
requirements:

B The input/output signature must conform to the specification
wm.swiftnet.server.doc; SWIFTNetServerSideProcessingRule in the WmSWIFTNetServer
package. To do so, in Developer specify the SWIFTNetServerSideProcessingRule
service in the Specification Reference field on the Input/Output tab of the mapping
service as illustrated in the following figure:
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For more information about this service, see Appendix 5, “webMethods
SWIFTNet Module Services” in this guide.

B The output must contain a string xmlIResponse. This is the response to the
incoming request that the server application sends back to the client application.

The SWIFTNet Module provides sample services in the
webMet hods6\ | nt egr at i onSer ver \packages\ WrSW FTNet Ser ver Sanpl e directory
that you can use or on which you can base new services.
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10 Click OK.

The following figure illustrates the main screen and the Action tab of the Processing

Rule Details screen with the necessary fields completed.
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Important! Because client and server applications cannot co-exist in the same process, if you
want to use both the client and server application services, you must install the
webMethods SWIFTNet Module on two different Integration Servers. You must use only
the WmSWIFTNetClient packages on one Integration Server and only the
WmSWIFTNetServer packages on the other Integration Server.
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WmSWIFTNetClient Package

This package contains the FileAct and InterAct services that support webMethods SWIFTNet Module
client-side functionality.

wm.swiftnet.client.doc

This folder contains the NS records representing the SNL primitives exchanged for FileAct and InterAct
operations.

wm.swiftnet.client.init
This folder contains services that perform initialization routines upon startup.

wm.swiftnet.client.init:startup

This service loads WiSW FTNet O i ent . dl | into memory. This DLL must be in one of the folders present in
“PATH” system environment variable. Ideally it should be present in the
webMet hods6\ | nt egr ati onServer\ i b folder.

wm.swiftnet.client.services

This folder contains services that exchange SNL primitives with SAG over RA. The service
wm.swiftnet.client.services.swArguments must have been invoked prior to invoking any other services in this
folder. The services in this folder can be invoked in a predefined sequence to perform a FileAct or an
InterAct operation such as putting a file, sending an interactive message, etc. In essence the services in this
folder are the building blocks to perform higher level FileAct and InterAct operations.

wm.swiftnet.client.services:createContextRequest

This service sends the SwSec:CreateContextRequest to SAG over RA and returns the
SwSec:CreateContextResponse received from SAG. This service requests SAG to create a security context.

Input Variables Type Description

SwSecCreate IData Request to create a security context.

ContextRequest

Output Variables Type Description

SwSecCreate IData Status indicating success or failure of security context

ContextResponse creation in SAG.

error String Whether an error occurred. Valid values: t r ue and
fal se.

errorXMLString String Optional - Error details received from SAG.
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wm.swiftnet.client.services:destroyContextRequest

This service sends the SwSec:DestroyContextRequest to SAG over RA and returns the
SwSec:DestroyContextResponse received from SAG. This service requests SAG to destroy a security

context.

Input Variables Type Description

SwSecDestroy IData Request to destroy a security context.

ContextRequest

Output Variables Type Description

SwsSecDestroy IData Status indicating success or failure of security context

ContextResponse creation in SAG.

error String Whether an error occurred. Valid values: t r ue and
fal se.

errorXMLString String Optional - Error details received from SAG.

wm.swiftnet.client.services:exchangeFileRequest

This service sends the Sw:ExchangeFileRequest to SAG over RA and returns the
Sw:ExchangeFileResponse received from SAG. This service requests SAG to perform a FileAct operation (a
get file or a put file). The information whether to put a file or get a file is specified in the
Sw:ExchangeFileRequest primitive.

Input Variables Type Description

SwExchangeFile IData Request to perform a FileAct operation.

Request

Output Variables Type Description

SwExchangeFile IData Status indicating success or failure of the FileAct

Response operation.

error String Whether an error occurred. Valid values: t r ue and
fal se.

errorXMLString String Optional - Error details received from SAG.
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wm.swiftnet.client.services:exchangeRequest

This service sends the Sw:ExchangeRequest to SAG over RA and returns the Sw:ExchangeResponse
received from SAG. This service requests SAG to send an InterAct message.

Input Variables Type Description

SwExchange IData Request to exchange a synchronous request.

Request

Output Variables Type Description

SwExchange IData Synchronous response received.

Response

error String Whether an error occurred. Valid values: t r ue and
fal se.

errorXMLString String Optional - Error details received from SAG.

wm.swiftnet.client.services:getFileStatusRequest

This service sends the Sw:GetFileStatusRequest to SAG over RA and returns the
Sw:GetFileStatusResponse received from SAG.

Input Variables Type Description

SwGetFileStatus IData Request to get the status of a file transfer.

Request

Output Variables Type Description

SwGetFileStatus IData File transfer status response.

Response

error String Whether an error occurred. Valid values: t r ue and
fal se.

errorXMLString String Optional - Error details received from SAG.

wm.swiftnet.client.services:initRequest

This service sends the Sw:InitRequest to SAG over RA and returns the Sw:InitResponse received from
SAG. This is the initialization primitive exchanged before any other primitives are exchanged.

Input Variables Type Description

SwinitRequest IData Initialization request primitive.
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Output Variables Type Description
SwinitResponse IData Initialization primitive response.
error String Whether an error occurred. Valid values: t r ue and

errorXMLString String

wm.swiftnet.client.services:sendRequest

fal se.

Optional - Error details received from SAG.

This service sends the Swint:SendRequest to SAG over RA and returns the Swint:SendResponse received
from SAG. This is the asynchronous version of Sw:ExchangeRequest primitive.

Input Variables Type

Description

SwintSendRequest IData

Output Variables Type

Asynchronous request primitive.

Description

SwintSendResponse  IData

error String

errorXMLString String

wm.swiftnet.client.services:sendSynchronousRequest

Response received from the RA client, not SAG.

Whether an error occurred. Valid values: t r ue and
fal se.

Optional - Error details received from the RA client.

This service formats the input request primitive into an XML string and then invokes the
wm.swiftnet.client.services:swCall service to send the request primitive to SAG over RA. The response XML
string received is then formatted into the appropriate response primitive.

Input Variables Type

Description

requestDocument IData

requestDocNSName  IData

responseDocNS IData
Name
Output Variables Type

Request primitive to be sent.
NS record name of request primitive.

NS record name of response primitive.

Description

responseDocument IData

error String

errorXMLString String

Response primitive received.

Whether an error occurred. Valid values: t r ue and
f al se.

Optional - Error details received from SAG.
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wm.swiftnet.client.services:signEncryptRequest

This service sends the SwSec:SignEncryptRequest to SAG over RA and returns the
SwSec:SignEncryptResponse received from SAG.

Input Variables Type Description

SwSecSignEncrypt  IData Request sign and/or encrypt payload.

Request

Output Variables Type Description

SwsSecSignEncrypt  IData Response received from SAG.

Response

error String Whether an error occurred. Valid values: t r ue and
fal se.

errorXMLString String Optional - Error details received from SAG.

wm.swiftnet.client.services:swArguments

This service initializes the client application with SNL libraries. The service a String[] of arguments as
input. The only mandatory parameter to be passed is the SAGMessagePartner defined in SAG. This service
invokes the “SwArguments()” function defined in the SNL libraries.

An example usage would be:
args[0] = “WISW FTNetd i ent”

args[1] = “-SagMessagePartner”
args[2] = “<message partner nane defined in SAG”
Input Variables Type Description
args String Initialization arguments to be passed to the SNL

libraries.
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wm.swiftnet.client.services:swCall

This service invokes the “SwcCall()” function in the SNL libraries to send a request primitive to SAG. The
response primitive received from SAG is then output to the pipeline.

Input Variables Type Description

xmlRequest String Request primitive to be sent to SAG.

Output Variables Type Description

xmIResponse String Response primitive received from SAG.

error String Whether an error occurred. Valid values: t r ue and
fal se.

errorXMLString String Optional - Error details received from SAG.

wm.swiftnet.client.services:termRequest

This service sends the Sw:TermRequest to SAG over RA and returns the Sw;TermResponse received from

SAG.

Input Variables Type Description

SwTermRequest IData Session termination request to SAG.

Output Variables Type Description

SwTermResponse String Session termination response from SAG.

error String Whether an error occurred. Valid values: t r ue and
fal se.

errorXMLString String Optional - Error details received from SAG.
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wm.swiftnet.client.services:verifyDecryptRequest

This service sends the SwSec:VerifyDecryptRequest to SAG over RA and returns the
SwSec:VerifyDecryptResponse received from SAG.

Input Variables Type Description

SwSecVerify IData Request to verify a signed/encrypted message.

DecryptRequest

Output Variables Type Description

SwSecVerify IData Message decryption response from SAG.

DecryptResponse

error String Whether an error occurred. Valid values: t r ue and
fal se.

errorXMLString String Optional - Error details received from SAG.

wm.swiftnet.client.services:waitRequest

This service sends the Swint:WaitRequest to SAG over RA and returns the Swint;WaitResponse received
from SAG. This is the primitive exchanged to retrieve a response asynchronously.

Input Variables Type Description

SwintWaitRequest IData Request to retrieve response asynchronously.

Output Variables Type Description

SwintWaitResponse IData Asynchronous response received.

error String Whether an error occurred. Valid values: t r ue and
fal se.

errorXMLString String Optional - Error details received from SAG.
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wm.swiftnet.client.util
This folder contains utility services.

wm.swiftnet.client.util:formatXML

This service formats an XML string by appending the following namespaces after the root tag. The
namespaces are “Sw”, “Swint”, “SwGbl” and “SwSec”. If these namespaces are not appended to the root
tag, the incoming XML response primitives cannot be converted into IData objects in the Integration

Server.

Input Variables Type Description

xmlRequest String XML string to be formatted with namespaces.

Output Variables Type Description

formatted XML String XML string with namespaces appended after the root
tag.

error String Whether an error occurred. Valid values: t r ue and
fal se.

errorXMLString String Optional - Error details received from SAG.

WmSWIFTNetClientSample Package

This package contains a sample implementation of the webMethods SWIFTNet Module client-side
functionality.

It provides sample services for sending SNL primitives to the server application. These services call other
services in the sequence required by SWIFTNet. You can use these services or use them as guides for
creating your own services. This package also provides sample mapping services that map a given set of
inputs into the XML primitive required by SWIFTNet.
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WmSWIFTNetServer Package

wm.swiftnet.server.doc

This folder contains the NS records representing the SNL primitives exchanged for FileAct and InterAct
operations.

wm.swiftnet.server.init

This folder contains services that perform initialization routines upon startup.

wm.swiftnet.server.init:startup

This service loads the WiSW FTNet Ser ver . dI | into memory. This DLL must be in one of the folders
present in “PATH” system environment variable. Ideally it should be present in the

webMet hods6\ | nt egr ati onServer\ | i b folder. This service then registers Integration Server process as
the server application for the message partner specified in the webMet hods6\ | nt egr ati onSer ver\
packages\ WrSW FTNet Ser ver\ confi g\ snl . cnf file. The following primitives are exchanged with SAG
on startup in that order.

1

o B~ W N

6

Sw:HandlelnitRequest
SwSec:CreateContextRequest
SwSec:CreateContextResponse
Sw:SubscribeFileEventRequest
Sw:SubscribeFileEventResponse

Sw:HandlelnitResponse

In addition the “SwcCallBack()” function in WmSWIFTNetServer.dll is registered as the call back function
with SNL libraries.
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wm.swiftnet.server.property

This folder contains services that load properties specified in the webMet hods6\ | nt egr at i onSer ver\
packages\ WiSW FTNet Ser ver\ confi g\ snl . cnf file.

wm.swiftnet.server.property:getCommonProperties

This service retrieves the most commonly used properties from the webMet hods6\ | nt egr ati onSer ver\
packages\ WiSW FTNet Ser ver\ confi g\ snl . cnf file.

Output Variables Type Description

SAGMessage String Must correspond to a “Server” type message partner

Partner defined in SAG.

server_pki_profile String User name of the profile defined in SAG.

server_pki_ String Password associated with the user name used to

password unlock the security information in SAG.

Sign,Decrypt and String Values are used for populating

Authorization SwSec:CreateContextRequest primitive exchanged
during server initialization. Valid values: Tr ue and
Fal se.

encryptDN String Distinguished Name to be used for encryption
operations.

AllFileEvents, String Values are used for populating

FullFileEvents Swi:SubscribeFileEventRequest primitive exchanged
during server initialization.Valid values: Tr ue and
Fal se.

SwEventEP String End point defined in SAG to handle FileAct

operations. This value is used for populating
Swi:SubscribeFileEventRequest primitive exchanged
during server initialization.

cryptoMode String Specifies whether crypto operations are performed
automatically by SAG/SNL. Valid values: Aut onat i ¢
and Manual .
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wm.swiftnet.server.property:getProperty

This service retrieves the value of the specified property from the webMet hods6\ I nt egr at i onSer ver\
packages\ WrSW FTNet Ser ver\ confi g\ snl . cnf file.

Input Variables Type Description

propertyName String Property value to be retrieved.
Output Variables Type Description

value String Value of the property.

wm.swiftnet.server.property:listProperties

This service retrieves all the properties specified in webMet hods6\ I nt egr at i onSer ver \ packages\
WISW FTNet Ser ver\ confi g\snl . cnf file.

Output Variables Type Description

properties IData All properties in the snl . cnf file.

wm.swiftnet.server.property:listProperties

This service reloads all the properties specified in the webMet hods6\ | nt egr ati onSer ver\ packages\
WBW FTNet Ser ver\ confi g\ snl . cnf file. This could be useful if more properties are added or existing
properties have been changed and the changes need to be reflected in the Integration Server immediately.

Output Variables Type Description

properties IData All properties in the snl . cnf file.

wm.swiftnet.server.services

This folder contains services to handle incoming requests.

wm.swiftnet.server.services:handleRequest

This service is invoked by the SwCallBack function in WrSW FTNet Ser ver . dl | when a request is received
from SAG. This service then recognizes the incoming request primitive as a TN document type and
invokes the processing rule specified by the user. The output of the service specified by the user for the
processing rule must contain the string variable “xmlIResponse” which is then passed back to SAG as the
response for the incoming request.

Input Variables Type Description

xmIRequest String Incoming request primitive.

52

webMethods SWIFTNet Module Installation and User’s Guide Version 6.0.1



WmSWIFTNetServer Package

Output Variables Type Description

xmIResponse String Outgoing response primitive.

wm.swiftnet.client.services:swCall

This service invokes the “SwCall()” function in the SNL libraries to send a request primitive to SAG. The
response primitive received from SAG is then output to the pipeline.

Input Variables Type Description

xmlRequest String Request primitive to be sent to SAG.

Output Variables Type Description

xmlResponse String Response primitive received from SAG.

error String Whether an error occurred. Valid values: t r ue and
fal se.

errorXMLString String Optional - Error details received from SAG.

wm.swiftnet.server.util
This folder contains utility services.

wm.swiftnet.server.util:formatXML

This service formats an XML string by appending the following namespaces after the root tag. The
namespaces are “Sw”, “Swint”, “SwGhbl” and “SwSec”. If these namespaces are not appended to the root
tag, the incoming XML response primitives cannot be converted into IData objects in the Integration

Server.

Input Variables Type Description

xmlRequest String XML string to be formatted with namespaces.

Output Variables Type Description

formattedXML String XML string with namespaces appended after the root

tag.
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wm.swiftnet.server.util:writeToFile

This service writes the given string or a byte[] to the specified file name.

Input Variables Type Description

FileName String Fully qualified file name or a file name relative to the
Integration Server home directory.

usrdata String Optional - String data to be written to the file.

bytesin byte [] Optional - Bytes to be written to the file.

Output Variables Type Description

errorStatus String Any error that has occurred while writing to the

specified file.

WmSWIFTNetServerSample Package

This package contains a sample implementation of the webMethods SWIFTNet Module server-side

functionality.

It provides sample services for handling incoming SNL primitive requests that need to be processed and
returned to the client. These services call other services in the sequence required by SWIFTNet. You can
use these services or use them as guides for creating your own services. This package also provides sample
mapping services that map a given set of inputs into the XML primitive required by SWIFTNet.
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Appendix A Configuring Transport Protocols

Overview

The transport protocols used with the webMethods SWIFTNet Module enable you to send
outbound messages to SWIFT as well as receive inbound messages from SWIFT. You can
connect to SWIFT using one of the following transport protocols:

B Remote Host Adapter. If you are connecting to SWIFT through RAHA, see Chapter 3,
“Configuring the webMethods SWIFTNet Module” in this guide.

B [BM MQSeries. If you are connecting to SWIFT through MQSeries Adapter, you must
install the webMethods MQSeries Adapter on the Integration Server. For more
information about configuring and using MQHA with the webMethods SWIFTNet
Module, see “Using MQSeries to Communicate with SWIFT” on page 56 in this guide.

B FTA. If you are using File Transfer Agent (FTA), you must configure the File Polling
Listener and AFT settings in the message TPA. For more information about
configuring and using the File Polling Listener with the webMethods SWIFTNet
Module as well as using File Drop for outbound messages, see “Using File Transfer
Agent to Communicate with SWIFT” on page 58.

Using MQSeries to Communicate with SWIFT

The webMethods MQSeries Adapter enables the webMethods Integration Server to send
and receive messages through the MQSeries interface and systems using an IBM
MQSeries message queue. This capability lets you route documents—or any piece of
information—from the Integration Server to systems that use MQSeries message queuing
as their information interface. The webMethods MQSeries Adapter enables you to connect
to SWIFT through MQHA.

Important! The following procedure assumes that you already have configured your
MQSeries and SAG to communicate with one another, as well as installed the
webMethods MQ Adapter. For more information, see the webMethods MQSeries Adapter
User’s Guide.

Configuring the webMethods MQSeries Adapter
If it is not running, start your Integration Server.
In the Server Administrator, click WebSphereMQ... under Adapters.

In the left Navigation Panel, click Queue Manager Settings.

A ow o N

Click Add Queue Manager Settings to define a Queue Manager using the instructions and
field descriptions in the webMethods MQSeries Adapter User’s Guide, and then click
Save. Make sure to set the Queue Manager Name field to the same name that you used
when defining your Queue Manager in MQSeries and SAG.

56

webMethods SWIFTNet Module Installation and User’s Guide Version 6.0.1



Using MQSeries to Communicate with SWIFT

5 Define two queues using the following steps:
a Click Queue Settings in the left Navigation Panel.

b From the Server Settings drop-down list, select the Queue Manager that you
defined in the previous step.

¢ Click Find Queues on this Queue Manager.

d Select the queues you defined for communication between MQSeries and SAG,
and then click Save.

6 Using the instructions in the webMethods MQSeries Adapter User’s Guide, click Msg
Handlers in the left Navigation Panel, select your Queue Manager, and then click Add
Message Handler to define two message handlers for the two queues you created in the
previous step.

a For the ‘put’ message handler:

Set this field... To...

Transaction Type IS-to-WebSphere MQ

Target Client Non-JMS Compliant Client

Note the Folder and Service Name that you define for this handler service.
Click Generate Service.

Click Continue.

Click Enabled.

AW N

b  Forthe ‘get’ message handler:

Set this field... To...

Transaction Type WebSphere MQ-to-IS

®  Under Inbound Service Details, click Listen, and then set the following fields.

Set this field... To...

Msg Service wm fin. transport. MXSeri es: getLi stenerService

Exception Service  The name of your exception service.

Target Client Non-JMS Compliant Client

® Click Generate Service.
¢ Click Continue.

d Click Enabled.
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7 Inthe TPA for the SWIFT message you will be sending and receiving using MQSeries,
set the following fields:

Set this parameter...  To...

Transport MQ
putMessage The name of the ‘put’ handler service, which you defined in
HandlerService the Service Name field.

8 In Developer, navigate to the ‘put’ message handler service you created, and set the
following:

®  msgHeader/MsgType variable to 8

m  msgHeader/ReplyToQueueManager variable to the same queue manager name that
you defined in the MQSeries and SAG

m  msgHeader/ReplyToQ variable to the appropriate ‘get’ queue

®  msgHeader/Report variable to 3 to get reports for all of the SWIFT messages you
send to SAG

Using File Transfer Agent to Communicate with SWIFT

Important! To use FTA, you must have the WmFlatFile package installed, which is installed
by default with the webMethods Integration Server.

File Transfer Agent (FTA) enables the webMethods Integration Server to exchange
information with other systems. If you are using FTA to receive inbound SWIFT messages
through the File Polling Listener, and File Drop capabilities to send outbound SWIFT
messages, the File Polling Listener and the message TPA must be configured properly.

Configuring FTA for Inbound Messages

I 7o configure the webMethods File Polling Listener for the webMethods SWIFTNet Module
1  Inthe Server Administrator, click Security » Ports » Add Port.
2  Select webMethods/FilePolling and click Go to Step 2.

3 Configure the File Polling Listener’s general fields as described in the “Configuring
Ports” section of the “Configuring the Server” chapter in the webMethods Integration
Server Administrator’s Guide.
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4  Set the following fields so that the File Polling Listener handles SWIFT messages

properly.
Set this field... To...
Content Type application/x-wnflatfile
Folder location The fully qualified path of the folder in which SAG will be sending

SWIFT messages. The folder must be accessible to both SAG and
webMethods Integration Server.

Processing Service wm fin.transport. AFT: processl nboundFi | e

Configuring FTA for Outbound Messages

To configure FTA using File Drop capabilities to send outbound SWIFT messages using

the webMethods SWIFTNet Module, you must complete the following procedure.
I 7o configure File Drop for the webMethods SWIFTNet Module

1 Map a network directory in which you want to drop files to be picked up by SAG,
which can be any directory in the webMethods Integration Server.

2 Inthe TPA for the SWIFT message, set the following parameters:

Set this field... To...
Transport AFT
Folder location The fully qualified path of the folder in which the webMethods

Integration Server will be dropping SWIFT messages. The folder
must be accessible to both SAG and the Integration Server.
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